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Introduction Executive Insight Quick Reference Guide
Introduction

Executive Insight increases the productivity of virtually every individual in an organization with faster, easier, and more 
efficient communications. Executive Insight allows Microsoft Outlook users to manage all their communications from 
within their email application. Users can instantly identify incoming calls, view all historical calls to and from their 
phone, call contacts (including Microsoft Outlook contacts) quickly and easily, as well as check and process all their 
messages. This guide provides step-by-step instructions on how to use the Executive Insight product.

Start Executive Insight

1. In Outlook, click the Connect icon.

2. The first time starting Executive Insight, you may be prompted to complete some initial setup using the Setup 
Wizard.

3. Optional: Set up Executive Insight to automatically start when Outlook is opened. 

a. From the Tools menu, select Phone.

b. Click the Load on Start option.

4. Executive Insight creates a folder in the Outlook mail folders named Phone. To return to the Executive Insight 
view at any time, open the Phone folder (or click your extension icon).

Note: Executive Insight does not automatically start when opening Outlook.
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The Executive Insight Interface

Toolbars

Show/Hide Toolbars

1. From the View menu, select Toolbars.

2. Click/clear the options to display/hide the toolbars.

Phone Toolbar

Toolbar options change dynamically based on current activity.

Icon Name Description

Answer Answers a call (only appears when a call is presenting).

Dial Dials a contact.

Hang Up Hangs up a call (normally grayed out; this button is only 
available when on a call).

Hold/Unhold Holds/unholds a call. Hold music plays for the caller 
while on hold.
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Speed Toolbar

Speed buttons for frequently used Phonebook contacts can be placed on a Speed toolbar to provide quick dialling 
and a visual indication of an internal user’s Presence status.

Add a Speed Button

1. In the Speed toolbar, click the Customize icon.

2. Select Add Speed Button.

3. Using the Phonebook, select the contact name and then click the Add button.

Make a Call Using the Speed Buttons

 Click the contact’s Speed button, and then click the contact’s phone number or extension.

Transfer a Call Using the Speed Buttons

 While on a call, click the Speed button of the contact to transfer the call to, and then select that contact’s phone 
number or extension.

View a User’s Availability

 Hover the mouse over a contact’s Speed button to view the Presence status and ETR (if set).

Request Availability Notification

 Click the contact’s Speed button and then select either of the following:

• Notify Me when [Name] is Back when the extension is forwarded.
• Notify Me when [Name] is Off the Phone when the extension is busy.

A notification message displays when the contact is back/off the phone.

Park/Unpark Parks/unparks a call. Hold music plays for the caller 
while on park, but the line is free for you to make another 
call.

Forward All Calls/Cancel Forward All Calls Forwards all calls/cancels the forwarding of all calls.

Destination Cancel Cancels a transfer.

Complete Transfer Completes a transfer.

Icon Name Description
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Voice Messaging Toolbar

Phonebook Functions

Access the Phonebook

 Use any of the following methods to open the Phonebook:

• Click the Phonebook icon.
• Press Ctrl+P.
• From the Call menu, select Phonebook.

Search for a Contact

1. Optional: To refine the search, select a specific search directory..

2. In the Look for field, type the contact’s name.

Feature Name Description

View or change the current active Presence profile.

Mailbox Setup Accesses the mailbox setup.

Mailbox Either of the following:

• Click to automatically call voice messaging.

• View mailbox status:

– No messages.

– One or more ordinary messages.

– The caller is currently recording a message.

– One or more urgent messages.

Redirect Redirects an incoming call to voice messaging as a fax.
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3. In the Found Contacts section, select the contact’s name to display the associated contact numbers.

Add a New Contact

1. Click the Phonebook icon, and then select the directory that the new contact is to be in from the list of 
directories.

2. In the Found Contacts section, click the Add a New Name (+) icon.

3. Enter the contact’s details, and then click OK.

4. In the Found Contacts section, select the new contact.

5. In the Numbers/Addresses section, click the Add a New Number icon.

6. From the Type menu, select the number type.

7. Enter the other required details, such as country code, area code, and number. The number must contain a 
country code, area code, and the actual number; otherwise it cannot be dialled from Desktop.

8. Click OK.

9. To add additional contact numbers, repeat steps 5 though 8.

Edit Contact Details

1. Click the Phonebook icon, and then either:
• Select either the contact name or number, and then click the Configure this Name/Number icon.
• Right-click either the contact name or number, and then select Properties.

2. Update the contact’s information, and then click OK.

Delete a Contact

1. Click the Phonebook icon, and then either:

• Select either the contact name or number, and then click the Delete this Name/Number (–) icon.

• Right-click either the contact name or number, and then select Delete.

2. When prompted to confirm the deletion, click Yes.

Note: For New Zealand area codes, the leading 0 is not required.
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Presence

Presence buttons provide real-time visual information on the whereabouts and availability of staff. If an employee is 

out of the office or in a meeting, the system displays the Due Back time. When an employee is away from the desk or 
on a call, you can request an automatic notification alert for when the employee is available. Use the Presence 
buttons to call staff. Presence buttons can be grouped and arranged on separate pages.

Presence Buttons

The following are two types of Presence buttons:

Presence Icons

External = Telephone numbers outside the office.

Internal = Extension numbers in the office. Use the Internal Presence buttons to:
• View the user’s extension status by viewing the icons and the status tooltip. 

• Perform advanced call functions for an extension by right-clicking the icon. A user’s 
name displays in yellow text if logged into queues as an agent.

Icon Description

Phone Call Types

(Gray) Extension is idle.

(Various colors) Extension is ringing or offering.

(Various colors) Extension is busy (on the phone).

Extension is forwarded to another number (internal or external).

Forwarded to voicemail.

(Green) Inbound non-queue call.

(Pink) Outbound non-queue call.

(Yellow) Inbound queue call (if queuing is installed).

(Blue) Outbound queue call (if queuing is installed).
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Additional Functions Using the Presence Buttons

Display Additional Contact Numbers

1. In the Active Calls window, click the Phone Status icon to display additional contact numbers.

2. From the menu, select the number to call.

Profiles

In the office.

In a meeting.

Out of the office.

On vacation.

(Gray Head) Agent is logged into the queues.

Voicemail Status

No messages.

One or more standard messages.

One or more urgent messages.

Icon Description
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Right-Click a Presence Button for Additional Menu Actions

 Right-click a Presence button, and then select the preferred action from the menu.

Note: The actual options available depend on the type of PBX being used, how the system is set up, 
and the enabled security permissions. Certain options are also only visible when there is an active call 
on the extension.

Icon Name Description

Call User on Extension Initiates a call to the user on the designated telephone number.

Supervised Transfer to User Transfers the Active Call to the user’s extension, and talk to the user 
before completing the transfer.

Blind Transfer to User Transfers the active call to the user’s extension.

Transfer Call Transfers the active call to the user’s extension.

Park for User Holds the active call at the user’s extension; the user can then retrieve 
the call.

Advanced Park Parks the active call and pages the user.

Notify Me when User is Back A ScreenPop informs when the user is in the office and available to 
take the call.

Forward All Calls Forwards all calls to a specified internal or external number.

Leave a Voice Message Record a voice message for the recipient.

Transfer to Mailbox Transfers the active call to the user’s voicemail.

Ask User to Call Me Back The user receives a ScreenPop callback request upon return.

Record Conversation to 
Mailbox

The conversation saves to the current user’s mailbox (if installed).

Send Message to Digital Phone Sends a short text message to the LCD screen of the user’s digital 
phone.

Select Presence Profile Changes the user’s Presence profile.

Rename Renames the Presence button. 

Delete Deletes the Presence button.

View As Changes the Presence buttons’ appearance.
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Set Presence Profile

 Use either of the following methods to select a preferred profile:

• The Presence list.
• Right-click a Presence button, and then select Select Presence Profile.

Set an Estimated Time of Return (ETR)

An Estimated Time of Return (ETR) can be set for the Presence profiles used when you are not available.

1. Select a profile, and then click the calendar function.

2. Select the date of return.

3. Select the approximate time of return using the standard times in the left window, or by setting the time using the 
clock field’s up and down arrows.

4. Click OK to save the ETR and activate the selected Presence Profile.

Note: Unless the ETR is set as mandatory in the system settings, an ETR can be skipped by clicking the 
Skip ETR button.
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Presence Status

Your Presence status is indicated in the Status Bar. The status information can be viewed by other users via your 
Presence button or from the Phonebook.

Add a Presence Note

This section describes how to add a personal Presence note to your Status Bar with additional information about 
activities and availability to coworkers.

1. In the Status Bar, click the Presence note text <type Presence note here>. 

2. Type the information, and then press Enter. This Presence note remains until it is cleared or a new note is 
created.

Add a New Presence Page

Use the Add Presence Page wizard to create either Standard or Dynamic Presence pages:

• Dynamic = Automatically lists the contacts for a company or department.
• Standard = Manually add and arrange the contacts.

1. Use either of the following methods to start the Add Presence Page wizard:
• From the File menu, select Add a New Presence Page.
• Right-click in the Presence window, and then select Add a New Presence Page.

2. Click Create Personal Presence Page (only administrators can create global pages), and then click Next.

3. Select the type of page to be created. Click either:
• Standard Page to manually add and arrange Presence buttons. If chosen, proceed to the next step.
• Automatic Page = Automatically adds and updates Presence buttons for the selected company/

department. If chosen, complete the following substeps.

a. Select a company from the listed companies, and then click Next.
b. Optional: Select List Only Contacts for the Selected Departments, and then click Next.

c. Click the department(s) to display if the department option was selected in the previous step, and then 
click Next.

d. Optional: Click the Create Additional Pages option, enter the number of buttons per page, and then 
click Next.This option defines a maximum number of Presence buttons per page and automatically 
creates an additional page when this maximum is reached.

4. Type a name for the Presence page, and then click Next.

5. Verify the settings and click Finish to create the Presence Page.

Note: Only users with System Administrator rights can add or edit Global Presence pages.

Note: This step only displays if departments have been defined.
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Rename a Presence Page

1. Use either of the following methods to rename a Presence page:
• From the File menu, select Rename this Page.
• Right-click in the Presence page, and then select Rename this Page.

2. Type the new name for the page, and then click OK.

Delete a Presence Page

1. Open the page to delete.

2. Right-click in any blank area, and then select Delete this Page.

3. When prompted to confirm the deletion, click Yes.

Add a Presence Button

1. Right-click in the Presence page, and then select Add a Presence Button.

2. Select either the contact name or the contact number (or drag a contact name or number from the Phonebook to 
the Presence page), and then click OK.

Delete a Presence Button

 Right-click a Presence button, and then select Delete.
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Call Functions

Make a Call

 Use any of the following methods to make a call:

• Use the Phonebook:

1. Click the Dial icon.

2. Click the Phonebook icon, and then select the preferred contact name/number.

3. Click the Call button, and then press Enter.
• Use the Presence button by either clicking the:

– Preferred contact’s Presence button to call the contact’s default number.

– Phone Status icon on the contact’s Presence button, and then click the preferred number.

• Click a contact’s Speed button on the Speed toolbar, and then select one of the contact’s numbers.

Answer a Call

 In either the Phone toolbar or Phone Calls window, click the Answer icon.

Active Call Icons in the Phone Calls Window

Icon Description

Hangs up the active call.

Places the active call on hold.

Parks the active call.

Either:

• Transfers the active call to the entered transfer destination number.

• Used to conference a third-party into a call.

Completes the transfer (or hang up the phone).

Cancels the transfer.

Swaps the calls (e.g., connects to the original caller or the transfer destination).

Records the conversation from the active call.
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Transfer a Call Using the Phonebook

1. While on an active call, click the Dial icon and then the Phonebook icon to open the phonebook.

2. In the Found Contacts section, select the contact to transfer the call to.

3. In the Numbers/Addresses section, select the contact’s number to transfer the caller to.

4. Click the Transfer button.

Voice Message Functions

Play a Voice Message

1. In the Calls window, either:
• Double-click the voice message.
• Right-click the voice message, and then select Play Message.

2. Click either the Phone or Speaker icon.

3. Click the Play icon.

4. At any time while the message is playing, click the:
• Stop icon to stop the playback.
• Volume slider to adjust the volume.
• Rewind icon to rewind the message.
• Pause icon to pause the message.
• Fast Forward icon to fast forward the message.

5. To save the message as a .wav file on the PC, click the Save icon. Play the file using the Windows Media Player 
or another compatible multimedia program.

Forward a Voice Message

Use the Forward Message feature to forward the voice message to a mailbox user or a distribution list.

Delete a Voice Message

Use the Delete Message option to delete a voice message.

Note: To assist the transfer, stay on the line until the party has picked up (otherwise complete the call 
right away).

Note: If the Keep a Copy option is not chosen, the message deletes from the mailbox.
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Desk-to-Desk Chat

Use Desk-to-Desk chat to have a conversation in real time with other internal users by typing text.

 Click the Chat tab to open the Chat window.

Chat Buttons

Button Description

Starts a new chat call to either a selected chat user or chat queue.

Ends the current chat call.

Transfers the current chat call to either a selected chat user or chat queue.

Invites one or more chat users to join the current chat call. Invitees must accept the invite to join.

Select the chat window, and then click the Copy button to copy the chat window to the clipboard.

Saves a transcript of the chat conversation in a text format to a specified disk directory.

Transmits the typed text. Alternatively, press the Enter key.

Closes the current chat window.

Adds, edits, or deletes standard chat phrases or commonly used URL links

A list of saved text phrase. When selected, the phrase is sent directly to the other chat parties.

A list of saved URLs. When selected, the URL is sent as a link directly to the other chat parties.

Pushes the current Desktop browser URL to the chat recipients.

Automatically sends a series of web page URLs while navigating using the Desktop web 
browser—toggles this feature on and off.
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Make a Chat Call

1. Click Initiate Chat to start a new chat call.

2. Click either Chat User or Chat Queue, and then select the specific entry from the list.

3. Click the Chat button in the window, and a new conversation window opens. 

4. In the message text field, type the message and then click Send Text (or press the Enter key) to transmit the 
typed text. An outbound chat call shows as waiting in the Active Calls window until the recipient answers the call.

End a Chat Call

1. Click End Conversation.

2. Optionally, click Save Conversation to save a transcript of the chat conversation in a text format to a specified 
disk directory.

3. Click the Close button to close the conversation window.

Answer a Chat Call

1. When a new chat call message displays, either click:
• Accept to answer the chat call, and then navigate to the Chat window by clicking the Chat tab. 
• Show Call to display the Chat window, and then click Accept.

2. In the message text field, type the reply message and then click Send Text (or press the Enter key) to transmit 
the typed text.

Transfer a Chat Call

1. Click Transfer to transfer the current chat call.

2. From the list, select a chat user or queue.

3. Optionally, click the Include Current Chat Conversation option to give the recipient access to the prior 
dialogue. 

4. Click Transfer to complete the call transfer.

Invite Additional Chat Participants

1. Click the Invite icon.

2. Select one or more chat users to join the current chat call.

3. Optional: Click the Include Current Chat Conversation option to give the invitees access to the prior dialogue.

4. Click the Invite icon to send the invitations. Invitees must accept the invite to join.

Chat conversation—when pink, an outbound chat conversation.

Chat conversation—when green, an inbound chat conversation.

Button Description
NEC Corporation of America ©2011 006NEC0307-00QRGR 15



Desk-to-Desk Chat Executive Insight Quick Reference Guide
Private Chat

When there are three or more chat participants, you can have a private chat with a selected participant.

1. Right-click the participant’s name.

2. From the menu, select Private Chat to [name]. A new chat window opens to enable the private chat session.

Chat Messages

The Chat Messages feature provides an organized listing of chat conversations and chat users. Select the required 
category and then use the right-click menu to access the available functions for the selected chat session or user. 

Create and Use Templates

Use the Desktop Agent templates to save and use commonly-used phrases and URLs when chatting.

Create Template

1. Click the Chat Templates icon.

2. Click either the Phrases or Links tab in the Templates window. The existing entries that display can be edited or 
deleted.

3. Click Add and enter a suitable label and the associated text or URL.

4. Click OK.

Use Template

1. Click the down arrow for either of the following icons:
• Chat Templates
• URL

2. Select the required item from the menu.

The text phrase is automatically sent to the other chat parties. The URL is pushed to the other chat parties.

Help: For more details on Chat Messages and additional functions and configuration settings, refer to the 
online help.

Note: When a URL is received in:

• Desktop, the URL shows as an active link and the built-in Web Browser automatically opens the 
web page.

• Executive Insight, the URL shows as an active link.
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Additional Chat Functions

 Refer to the online help for additional less-frequently used functions and configuration settings.

Configure the Add-in Options

Use Outlook’s CTI Add-in function to configure Executive Insight and set user preferences.

 From the File menu, select CTI Add-in.

Note: Refer to the online help and the User Mailbox Setup Quick Reference Guide for more details.

Item Description

The CTI Add-in menu option.

Set the required start-up options.

Set up user-defined preferences for Executive Insight. When set, these usually do not need to be changed 
again.

Set up or edit personal mailbox settings, including recorded Presence profile greetings and the mailbox 
schedule. The first-time start up wizard initially assists in configuring the essential settings.

View Executive Insight’s version details.
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